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1 Introduction 

Congratulations on your purchase of the Mezzo I-Track system kit. This kit along with the Mezzo 
Sound Intensity Probe provides an innovative and cost-effective solution for sound intensity 
imagery. More than just an imaging system, the I-Track system provides a very accurate sound 
power measurement system. 

The current user’s manual describes the Mezzo I-Track kit and software. For more information on 
the Mezzo Sound Intensity Probe, refer to the Mezzo Sound Intensity Probe with Mezzo Intensity 
Analyzer module user guide. 
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2 Specifications 

Included Accessories 
Component Description 

Digital Camera 1600x1200, USB 2.0, CMOS Color Digital Camera, Optically Corrected wide-angle lens 
Manual Iris and Focus, FOV 120° (Wide mode), 82° (Zoom mode) 

Tracking Pad 170x170 mm, acoustically transparent 

Tracking Pad 
Holder Plastic L-shaped tracking pad holder, 85x63mm 

USB Cable 3 m USB 2.0 cable with Mini B connector 

Case Plastic transport case, 450x395x115mm (17.75x15.5x4.5”) 

 

Module Specifications 
Specifications 

Spectrums 
1/1 Octave , 1/3 Octave, 1/24 Octave, or FFT 

(user defined bandwidth to fit microphone spacer, from 10Hz to 20kHz) 

Frequency Weightings A, C and Z 

Metrics (Spectrum and Global levels) Pressure, Intensity, PI index (F3), P|I| index (F2), 
Extraneous Sources index (F3-F2), Sound Power 

Instant Rate Variable from 50ms to 1s 

Phase Mismatch Compensation FIR-IIR phase correction filters 

Environmental Compensation Compensation for Atmospheric Pressure, Temperature and Humidity 

Tracking 
Optical Tracking using digital camera, 6 Degrees of freedom (DOF),  

Real-World units 

Camera Resolution 800 x 600 

Measurement Plane 6 DOF Position and Area automatically computed using 3D data points 

Interpolation Constrained Delaunay Triangulation 

Averaging 2D Gaussian averaging (user defined size from 0 to 1m radius) 

Standard Compliance IEC 61043 (1993) 

 

Computer Requirements 
Item Minimum Requirements 

Operating System Windows XP SP3, Windows Vista, Windows 7, Windows 8 

CPU Dual-Core at 2.4 GHz 

Memory 2 GB RAM 

Hard drive 300 MB free hard disk space 

Port USB 2.0 

Display resolution 800 x 600 
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3 Setting Up the Tracking Pad 

1) Install the tracking pad holder onto the Mezzo Sound Intensity Probe; 
2) Make sure the holder is close fitted to the handle body; 

 
 

3) Take the tracking pad and place it face down on a table. Make sure the table is clean to 
avoid staining the fabric; 
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4) Fasten the tracking pad to the holder using the two thumb screws; 

 
 

5) Adjust the position of microphone 2, it should be 85mm from the table and the probe 
reference axis should be perpendicular to the table surface; 
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4 Setting Up the Digital Camera 

1) Install the digital camera on a tripod and position it towards the device under test 

 
 

2) Connect the camera using the USB cable 
3) Locate the control rings for Iris and Focus, they will be useful during tracking setup (refer to 

section 5.4, Setting Up Probe Tracking and Background Picture, p.13); 

 
 

 

* Tripod not included 
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5 Setting Up the Mezzo I-Track Module 

5.1 Setting Up Input 

Click on the  button from the “Setup” tab to enter the input setup: 

 

5.1.1 Retrieving Microphone Set Information from Mezzo Sound Intensity Probe 

Click on the “Mic Set” button: 

 

Click on the “Load Info From Mezzo” to load the calibration information from the Mezzo Sound 
Intensity Probe: 
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5.1.2 Calibrating each microphone 

Click on the “Calibrate Mic A” button: 

 

Enter the calibrator level and frequency. 

Insert the microphone in the calibrator: 
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Turn ON the calibrator and click on “Run” 

 

Click on “Stop” when level is stable 
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The calibration function will adjust the sensitivity according to the measured level and the 
calibrator level at the calibrator frequency. 

Click OK to accept. 

Repeat for the second microphone. 

Note: The calibration level can be checked by clicking “Check” instead of “Run”. This allows to 
measure the calibration level without changing the sensitivity. It is recommended to check the 
calibration after each measurement campaign to validate the correct operation of the probe. 

 

Click on the “Enable Phase Comp.” button. It is recommended to enable the phase mismatch 
compensation to increase the Pressure Residual Intensity Index and thus increase the dynamic 
capability of the probe.  
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5.1.3 Selecting the Microphone Spacer 

Click on the “Mic Spacer” button. 

 

The microphone spacer is an important part of the sound intensity measuring technique using a 
pair of microphones. Separated by a distance, the two microphones can measure the sound 
particle velocity by using the pressure gradient. However for this estimation to be right, the 
separation distance must be adapted to the wavelength. The following table shows the different 
spacers and their associated bandwidth relative to the degree of precision: 

 Laboratory Expertise Control 

Probe Intensity Response (H-F Limit) < 1 dB < 2 dB < 3 dB 

Pressure Residual Intensity Index (L-F. limit) > 15 dB > 12 dB > 9 dB 

12.5 mm 200Hz – 5kHz 100Hz – 6.3kHz 50Hz – 8kHz 

25 mm 100Hz – 2.5kHz 50Hz – 3.15kHz 25Hz – 4kHz 

50 mm 50Hz – 1.25kHz 25Hz – 1.6kHz 12.5Hz – 2kHz 

Only the selected bandwidth is considered during the measurement. Hence, only the bands 
located in the selected spectrum region will be calculated. Also, the Global levels (A, C and Z) will 
be computed on this reduced bandwidth using a band-pass filter. 

To cover a wider range, it is recommended to perform two measurements using two different 
spacers. 
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5.2 Selecting Data Type 

Click on the  button to select the spectrum type: 

 

Use the spectrum drop-down list to select from the available spectrum types (1/1, 1/3, 1/24 Octave 
or FFT). The lower indicator shows the resulting bandwidth. Note that the available bandwidth is 
affected by the microphone spacer bandwidth. Refer to section 5.1.3, Selecting the Microphone 
Spacer, p. 10 for more information. 

The instant rate is the live data rate. This rate only affects the display rate with the fractional octave 
spectrums (1/1, 1/3, and 1/24 octave). When using the FFT spectrum, this parameter has also an 
effect on the frequency definition of the spectrum using the following relationship: 

𝑑𝑑 (𝐻𝐻) =
48832 (𝐻𝐻)

⌊48832 (𝐻𝐻) × 𝐼𝐼𝐼𝐼𝐼𝐼𝐼 𝑅𝐼𝐼𝑅 (𝐼)⌋
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5.3 Selecting the Record Directory 

Click the  button from the “Setup” tab: 

 

The I-Track module automatically saves data to a measurement file when the measurement starts, 
so there is no need to worry about saving afterwards. 

Browse to the desired record directory where measurement files will be saved. The recorded files 
will have a 0001.itr pattern. It is recommended to create a record directory for each measurement 
campaign. 

The default record directory is C:\Users\CurrentUser\Documents\Mezzo\ITR. 
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5.4 Setting Up Probe Tracking and Background Picture 

5.4.1 Taking a Background Picture 

Position the camera at approximately 2 m from the device under test (DUT). 

 

Note that the camera can be closer or farther to view the whole source. 

Click the  button from the “Setup” tab to enter the “Tracking Setup” interface: 
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Click on the  button to take a background picture: 

 

Adjust the iris opening on the camera lens by loosening the thumbscrew and rotating the “open-
close” ring until the lighting on the image is appropriate. Usually the iris should be fully open but 
there might be situations which require less light such as a very bright sunny day. Secure the 
thumbscrew when the adjustment is performed. 

Adjust the focus by loosening the thumbscrew and rotating the “far-near” ring until the image is 
sharp. This step is important as it will affect the probe tracking. The sharper the image is, the best it 
will perform. 
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5.4.2 Testing Probe Tracking 

While taking the background picture you can test the probe detection by placing the probe in the 
measurement plane just like in measurement mode. If the probe is detected, it will be displayed 
with a magenta square around the pattern and a magenta dot on the microphone position. Also, 
the status light on the probe will be green: 

 

When satisfied with the background image, click on the  button. 

Click “OK”. 

Note: Two view settings are available “wide-angle” and “zoom”. The “wide” mode is used most of 
the time as it allows to place the camera close to the device under test. The “zoom” mode is used 
when it’s required to place the camera farther from the device under test. 

Note : The “Max Probe Speed” allows to define a maximum scanning speed on the probe. The 
default maximum speed is 0.5m/s which is defined in ISO 9614-2. 
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5.4.3 Defining a Custom Measurement Surface 

The I-Track system can determine the measurement plane automatically at the end of the 
measurement using the cloud of measurement points. However, it’s possible to determine the 
plane surface manually. If you don’t want to use a manually defined plane, skip these steps. 

1) Click on the  button to start the process; 
2) Position the probe at the origin of the plane (0,0,0) 

 
 

3) Click the  button on the interface or the  button on the probe to accept and 
go to the next step; 

4) Position the probe on a second point along the horizontal axis (X axis): 

 
 

5) Click the  button on the interface or the  button on the probe to accept and 
go to the next step; 
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6) Position the probe on a third point on the plane to define the vertical axis (Y axis): 

 
 

7) Click the  button on the interface or the  button on the probe to accept the 
third point. 

 

This custom measurement plane will be used to perform the measurement. 
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6 Performing a Quick Field Check 

Click on the  button from the “Tools” tab: 

Locate the sound intensity towards the sound source and check the compass indicator: 

 

The compass indicator should be in the red region indicating a PI index inferior to 3 dB and positive 
intensity. 

Locate the sound intensity away from the sound source and check the compass indicator. Be sure 
to locate the sound probe at the same point. You can use a tripod or a similar object as a reference 
point. 

 

The compass indicator should be in the blue region indicating a PI index inferior to 3 dB and 
negative intensity. 

Note that pressure and intensity levels should be very close when pointing towards and away from 
the source. 

Mic 1 Mic 2 

Mic 1 Mic 2 
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7 Performing a Measurement 

7.1 Method of Measurement 

Sound intensity measurements are performed on an integrating box around the device under test 
(DUT). Each surface is measured using a scanning technique to measure the sound intensity of this 
surface. The sound intensity level can then be converted to sound power level using the area of the 
measuring surface. 

The traditional method requires that the scanning path must be uniformly distributed on the 
measurement surface and it must be followed with the probe at a constant speed. Great care must 
be taken to select an appropriate path and measure using a constant speed. 

 

The I-Track system uses direct spatial averaging and does not require to follow a specific path nor 
does it require a constant scanning speed. However, it’s recommended to use a scanning pattern 
to distribute the points evenly on the surface as it will produce a better looking image and more 
precise results. 

The probe must be held so that: 

• The reference axis of the probe is perpendicular to the measurement plane; 
• The measurement surface crosses the reference axis of the probe at the reference point of 

the probe; 
• The probe reference direction must be pointing towards the source (into the bounding 

box). 

 

Reference Axis 

Measurement 
Surface 

Mic 1 Mic 2 

Sound Source 
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7.2 Step-by-Step Operation 

1) Position the probe perpendicularly to the measurement surface. 

2) Back to the main interface, click the  button on the interface or press the  
button on the probe to start the measurement. 

 
 

3) Following the measurement start, the background picture will be displayed on the main 
interface. 

4) Move the probe on the measurement plane using a horizontal or vertical scanning path. 
The acquired data should be displayed on the screen as the measurement progresses. 
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5) Continue the scan to cover the whole measurement plane. You can scan beyond the limits 
of the scanning plane as you can crop it afterwards in post-processing. 

 
 

6) Once the first pass is done, it is recommended to perform a perpendicular scanning path. 
Over the first pass. Hence, if the first pass is a vertical scanning pattern, perform a horizontal 
scan over the first pass. 
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7) At the end of the measurement, click the  button on the interface or press the 

 on the sound intensity probe. The data is automatically saved during the 
measurement, so don’t worry about saving. Once the measurement is done, the following 
operations are performed automatically: 
• Check validity of each measurement point (over-range and under-range) 
• Compute a measurement plane using the cloud of points in XYZ. (This step is not 

performed if a manual plane definition was performed before the measurement.) 
• Check the validity of each point in reference to the plane (maximum distance and angle 

of probe to the plane). 
• Triangulation and interpolation of each point on the measurement plane. 
• Compute sound image and spatial average level for the spectrum cursor. 

 
 

8) To view the image of a specific frequency band, click on the spectrum graph or the global 
graph at the bottom of the interface to display the corresponding sound image. 

IMPORTANT : Once the measurement is completed, the spectrum and global levels are 
approximated using the measurement points only. This allows to show the spectrum rapidly, even 
when using FFT. To compute the exact level, the spatial average must be computed for each band. 

This can be done by simply clicking on one band in the spectrum or by clicking on the  button 
next to the spectrum to compute all bands at once. Note that bands which are in a light red or a 
light blue indicates an approximated level. For more information, refer to section 8.2.1, Exact vs 
Approximate Levels, p. 26. 
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8 Analyzing Data 

8.1 Theory 

8.1.1 Sound Intensity vs Sound Pressure 

Sound Intensity is a vector quantity with a magnitude and a direction. It represents the rate of 
sound energy flow through a unit area. 

A sound intensity probe using a pair of pressure sensing microphones will pick-up only the vector 
component which is in-line with the reference axis of the probe. Hence, a sound intensity probe 
measures the normal component of sound energy flow through a surface. 

 

Thus the normal energy flow will equal the full magnitude of the sound intensity vector when the 
vector is in line with the reference axis. It will be positive when pointing in the reference direction 
(from mic 1 to mic 2) and it will be negative when pointing in the opposite direction (from mic 2 to 
mic 1). In addition, a null energy flow will be measured when the vector is perpendicular to the 
reference axis. 

 

Reference Axis 

Vector 
Energy Flow 

Normal 
Energy Flow 

Measurement 
Surface 

Mic 1 Mic 2 

Reference Axis (Reference 
Direction) 

Positive 
Energy Flow 

Negative 
Energy Flow 

Null 
Energy 
Flow 
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On the other hand, the sound pressure level indicates the sound pressure energy regardless of the 
direction of the flow of energy. Thus, with the energy flow vector in the reference axis, both sound 
intensity level and sound pressure level will give the same result. However, with the energy flow 
vector perpendicular to the reference axis, the sound pressure remains unchanged but the sound 
intensity will be null. 

The following image shows the directivity pattern of the sound intensity probe. 

 

For example, a sound field yielding a sound pressure of 75 dB yields a sound intensity level of 75 dB 
when the direction of propagation is in-line with the reference axis. The sound intensity level will 
be 72 dB when the direction of propagation is 60° with respect to the reference axis, and –inf dB 
when it’s 90°. 

8.1.2 PI index 

In practice, the sound field is not perfectly perpendicular to the measuring surface. Hence, there 
will always be a difference between the sound intensity level and the sound pressure level. The 
absolute difference between Pressure and Intensity levels is known as the PI index. 

𝑃𝐼 = 𝐿𝐿 − 𝐿𝐿 

A high PI index (> 6dB) indicates a low intensity level compared to the pressure level. This means 
that the sound field is either reactive or that its propagation is mostly perpendicular to the 
reference axis. 

A low PI index (< 2dB) indicates a sound intensity level close to the sound pressure level. This 
means that the propagation of the sound field is mostly in-line with the reference axis. 

0° = 0dB 

60° = -3dB 
90° = -inf dB 

30° = -0.6dB 
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8.1.3 Advanced Indicators 

Extraneous Sources 

The extraneous sources index (Called F3-F2 in ISO 9614-1 and F+/- in ISO 9614-2) indicates the 
difference between the average sound intensity level and the average of absolute sound intensity 
levels. 

𝐸𝐸𝐼. 𝑆𝑆𝑆. = 𝐿|𝐿| − 𝐿𝐿 

When the extraneous sources indicator is close to zero (< 1dB), it means that the sign of the 
intensity does not change significantly during the measurement. 

When the extraneous sources indicator is high (> 6dB), it means that the sign of intensity changes 
significantly from negative to positive during the measurement. This is a strong sign of reactive 
field. 

P|I| index 

This index is called F2, or Surface Pressure-Intensity indicator in ISO 9614-1. It represents the 
difference between the average sound pressure level and the average of absolute intensity levels. 
It can be used to determine the extraneous sources index and is generally not used by itself. 

Sound Power 

This value shows the integrated sound intensity over the measurement plane surface. The sound 
intensity being expressed in W/m² and area being expressed in m², the sound power is the total 
power flowing through the defined measurement plane. 

𝐿𝐿 = 10 ∙ 𝐿𝐿𝐿 �
𝐼

𝐼𝑅𝑅𝑅
∙ 𝐴𝑆𝑅𝐼� 

𝐿𝐿 = 10 ∙ 𝐿𝐿𝐿 �
𝐼

𝐼𝑅𝑅𝑅
�+ 10 ∙ 𝐿𝐿𝐿(𝐴𝑆𝑅𝐼) 

𝐿𝐿 = 𝐿𝐿 + 10 ∙ 𝐿𝐿𝐿(𝐴𝑆𝑅𝐼) 
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8.2 Using the Mezzo I-Track Module to Analyze Data 

8.2.1 Exact vs Approximate Levels 

Once the measurement is completed or when a file is freshly loaded, the spectrum and global 
levels are approximated using the measurement points only. This allows to show the spectrum 
rapidly, even when using FFT. Note that bands which are in a light red or a light blue indicates an 
approximated level. 

To compute the exact level, the spatial average must be computed for each band. This can be done 
by simply clicking on one band in the spectrum to place the cursor on the wanted band or by 

clicking on the  button next to the spectrum to compute all bands at once. 

 
  

Compute exact 
level for all bands 

Light color means 
approximate level 

Strong color means 
exact level 



 

27 

Clicking on the  button next to the spectrum computes all bands at once. This process can take 
more or less time depending on the spectrum type and the number of bands, hence 1/3 octave 
bands spectrum take less time to compute than FFT spectrum. 

 

8.2.2 Changing the Sound Image Frequency Band 

The sound image displays a specific frequency band or global level. To change the displayed 
frequency, simply click on the spectrum or global graph or use the  buttons above the 
spectrum to change the frequency band. 

 
 

Strong color means 
exact level 

315 Hz 

1 kHz 
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8.2.3 Changing Data Type 

The “Display” tab shows the available data type to display. 

The  buttons allow to select which spectrum type to display from the recorded 
spectrums. See section 5.2, Selecting Data Type, p. 11. 

The  buttons allow to view the basic data which are Sound Intensity Level, Sound 
Pressure Level, and PI index. These data will be displayed both on the sound image and on the 
spectrum. Hence, when selecting Intensity, Intensity levels will be displayed both on the spectrum 
and on the sound image. 

When displaying sound intensity levels, the red bars shows positive sign intensity, whereas the 
blue bars shows the negative sign intensity. 

The  buttons allow to view the advanced field indicators which are P|I| index, 
Extraneous Sources, and Sound Power. These indicators are only displayed on the spectrum graph 
because they use the average data in their calculation, hence, they don’t have any meaning on the 
sound image where only discrete data can be displayed. 

The  buttons allow to add a dBA, dBC or dBZ frequency weight to the spectrum. Note 
that global levels in dBA, dBC and dBZ are always shown on the right of the spectrum. 

Note that frequency weighting only has meaning when displaying pressure or intensity levels. 
When displaying PI index the frequency weight of pressure and intensity are algebraically 
simplified resulting in an unweighted dB unit. 

The figures on the following page show respectively sound intensity, sound pressure and PI index. 
Based on the previous theory, the sound intensity image shows the sound energy component 
which is perpendicular to the measurement plane whereas the sound pressure image shows the 
scalar value of sound energy. Hence it is normal that sound intensity levels are lower than sound 
pressure levels. 

The lowest figure shows the PI index. This image represents the difference between intensity and 
pressure levels. Using the theory, we can say that a low PI index (<2dB) indicates that the energy 
flow is mostly perpendicular to the measurement plane. When it is high (> 6dB) we can say that the 
energy flow is mostly parallel to the measurement plane. 

When using sound Intensity levels and PI index together, it’s easy to identify a strong source 
location: where the sound intensity level is high and PI index is low it’s a strong indication of a 
significant sound source.  
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Sound Intensity 

Sound Pressure 

PI Index 
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8.2.4 Formatting the Sound Image 

Changing the Color Scale 

The “Mapping” tab shows several functions to format the sound image. 

The  button allows to change the color scale of the sound image. The default color scale 
setting uses the 10 most significant decibels. Hence if the maximum level of a sound image is 
67 dB, the scale maximum (red) will be 67 dB and the minimum will be 57 dB. 

When displaying intensity, it is possible to display “positive”, “negative” or “absolute” energy. When 
selecting “positive”, only the positive intensity will be colored, negative intensity portions on the 
sound image will be greyed. 

Layering more Information 

The  button allows to display layers of additional information on the sound image. 

Mapping Grid: 
 

The mapping grid displays the 
measurement plane in space. Each grid cell 

has a 10 cm side. This dimension is not used 
in computing, it is used only to display the 

plane dimension. 

 
 

Scanning Points: 
 

The scanning points are all the 
measurement points considered in the 

sound image computing. 
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Scanning Paths: 
 

The scanning paths show the continuous 
datasets acquired during the measurement. 

The paths may be discontinuous if the 
probe leaves the camera viewing range or if 

the user suspends the measurement. 

 
 

Interpolation Mesh: 
 

The interpolation mesh shows the structure 
used by the software to interpolate 
between measurement points. This 

triangular structure allows interpolating 
efficiently between data points. 

 
 

Intensity Vectors: 
 

The intensity vectors are estimated by 
analyzing the Pressure and PI index sound 

images. 
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Changing the Geometric View 

The  button allows to change the sound image viewpoint. The “Shift Background” function 
allows to shift the background image towards the measurement plane so that the device under 
test and the measurement plane are superimposed. This function is mostly useful when the 
measurement plane is skewed and DUT is far from the measurement plane, causing the DUT image 
and the sound image not to be perfectly aligned when viewing it on a 2D image. 

 

The “Front View” function allows to view the sound image as if the camera was pointing 
perpendicularly to the center of the measurement plane. 

 

  

DUT Image DUT Image 
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8.2.5 Adding Bounds 

When analyzing a sound image, it is often useful to concentrate on sub portions of the sound 
image. Hence bounds can be drawn on the sound image to restrict computing to a sub portion of 
the sound image. Thus sound power can be evaluated for specific sub-sources. 

Click on the  button and click on the sound image to add a new set of bounds. These bounds 

can be recalled using the  drop-down menu or deleted using the  button. 

The following example shows 3 bounds and their respective computed sound power: 

This first bound delimits a section the 
intake of the fan enclosure. The sound 

power level of this subsection is 74.5 dBA. 

 
 

This second bound delimits the rest of the 
chiller enclosure. The sound power level of 

this subsection is 71.5 dBA. 
 

One can notice that this subsection 
represents less power than the first 
boundary even if the area is larger. 

 
 

This third bound delimits the whole side of 
the DUT. The sound power level of this 

section is 76.2 dBA. 
 

The power sum of bounds 1 and 2 should 
be equal to this third one: 

74.5 dBA “+” 71.5dBA = 76.2 dBA 

 
 

Following the previous analysis, we can demonstrate that the fan intake section is the most 
significant sub source of the DUT even if it’s smaller in size than the rest of the surface. 
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8.2.6 Viewing the 3D Scene 

Click on the  button to launch the 3D scene viewer. This interface allows to view a 3D 
rendering of the measurement scene. Use the mouse to navigate in this interface. Ctrl and Shift 
keys are useful to pan and zoom. 

 

Note that layers are displayed accordingly; hence the intensity vectors can be seen in 3D as if they 
were coming out of the measurement plane. 
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8.2.7 Advanced Parameters 

Several parameters can be adjusted to change how the sound images are computed. It is 
recommended to use the default parameters but these can be adjusted to fit some specific 
situations. 

Click on the  button to access these settings: 

Averaging Radius 

The averaging radius represents the Gaussian averaging used to average the sound images. This 
allows to average measurement points located closely to one another with an averaging weight 
following a Gaussian shape. The default averaging radius is 10cm. A larger averaging radius leads 
to a smoother sound image and a smaller averaging radius leads to a more edgy sound image. 
Using 0 leads to no averaging. 

 

Maximum Interpolation Distance 

The maximum interpolation distance indicates the distance limit between each measurement 
point to allow interpolation. If scanning points are positioned too far from their neighbours, it 
becomes hazardous to determine data from the interpolation between these points. The default 
value is 0.5m and is considered forgiving. A more restrictive value of 0.2m is recommended but can 
lead to “holes” in the sound image if the measurement points are not close enough to each other. 

Maximum Distance and Angle to Plane 

These parameters are thresholds when determining the measurement plane from the cloud of 
measurement points. Each measurement point has a XYZ coordinate and XYZ angle in space. The 
measurement plane is determined using the least square distance of each point to the plane. Once 
the plane is determined, the points that are too far from the plane or not perpendicular enough to 
the plane will be rejected. Defaults are 0.1m and 20°, values of 0.2m and 40° are more forgiving. 
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9 Exporting Data 

9.1 Exporting a single sound image 

Click on the  button from the “Mapping” tab to export the current sound image to the 
clipboard. This map can then be pasted in another document (MS Word, etc.) as a .png file. 

9.2 Exporting average data 

Click on the  button from the “File” tab to export the average spectrum data to a tab delimited 
file which you can open in Excel or Matlab. 

9.3 Exporting all sound images and average data 

Click on the  button from the “File” tab to export the average data and all the sound image 
files. The exported files are stored in a compressed folder. 
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10 Viewing Measurement Info 

A measurement file contains all the setup information. It’s also possible to add a comment to a 

measurement file to document the measurement. Click on the  button from the “File” Tab to 
access the file info interface. 
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